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(1) View the spatial files in ArcGIS
The models and spatial files may be found in the following folder. If you are accessing this from
a remote computer, you’ll have to use VPN to connect to UT first.

\\austin.utexas.edu\disk\engrstu\class\caee\ce365k\CE365K2016

Navigate to this folder and download the model and spatial files corresponding to your site.

P 365k Semester Project

‘@(:)ﬂ  + Computer - OSDisk (C:) = 365k Semester Project = - &5

Organize *  Indudeinlibrary *  Sharewith + Burn  New folder

- Eavorites Mame = Date modified Type
s
B Desktop | Boggy Creek 3/25/2016 12:42PM  File folder
4 Downloads | Boggy Creek Spatial 3/25/2016 12:42PM  File folder

:
=l Recent Places

The Boggy Creek folder contains the City of Austin’s official HEC-RAS model for Boggy Creek.
The Boggy Creek Spatial folder contains spatial data for Boggy Creek that may be viewed using
ArcGlS.

To explore additional data available from the City of Austin visit: www.austintexas.gov/floodpro/

B
Open ArcMap , PEEESwES | and select “cancel” when the “ ArcMap — Getting Started” prompt

appears, seen below.


file://///austin.utexas.edu/disk/engrstu/class/caee/ce365k/CE365K2016
http://www.austintexas.gov/floodpro/

% ArcMap - Getting Started

Open existing map or make new map using a template

isting Maps Recent

Browse for more...
' Maps

: My Templates

mplates

- Standard Page Sizes
- Architectural Pag
- 130 (A) Page Siz Boggy Creek BC_CP_Major.gdb
- North American {

Traditional Layouts
- Industry
- USA

- World @I Q ]
Browse for more... J

N 2 RC CP Moderate.odh RC P Minor.ndh =

I Vaustin. utexas. edu'disk\engriresearch\crwr\Projects\NationalFloodInteropExp\CF_3-23-2015'8rushy Creek Maps\BC_CP_Moderate.gdb. myxd

Default geodatabase for this map: What is this?

™ Do not show this dialog in the future. Open Cancel

Navigate to File > Map Document Properties, and check the box next to “Store relative
pathnames to data sources”.

Then if you keep the map document and its data in the same folder and move the entire folder
between computers the references to the data in the map persist.

Map Document Properties E

#, Boggy Creek Spatial.mxd - ArcMap General |
File | Edit View Bookmarks Insert Selection Geoprocessing  Customize
[ Hew... QN B S L R x| File: 21365 Models\Boggy Creek Spatial.mxd
E% Orpen... Ctro = |
= Tikle: I
& soe Ctrl+s
Save As... Summary:
Save A COpY...
Share As 3
Add Data » Description: ;I
» [ 183 [Payi
E{E, SignIn... - 2
HH  arcais oniine...
Page and Print Setup...
@ Print Preview. .. _I
-
& Print...
Export Map... Author: I
Analyze Map...
- Credits: I
Map Document Properties. ..
1C:\365 ...\Boagy Cresk Spatial.m-= Tags: I
Map D t Properti
2.C1\365 Models\Boggy Creskumxd |7 o T OPErtes
) Display or edit the properties of this , ,
3 Waustin.u...\BC_CP_Major.adbum 121 Socument, such as description, Hyperlink base: I
author, credits, and specify whether
Vst PC_CP_Moderate. gdbuml o} bsced data it uses wil be
5 Ylaustin.u...\8C_CP_Minor.gdb.m  referenced by relative pathnames. Last Saved: 3/25/2016 1:49:50 PM
& F:iFlood Map Book.myd )
Last Prinked:
7 1a...\BC_FloodMapBookz. gdb.med
& .. \UpBrCrielocity-Tndun11-10-14... "4 L Last Exported:
9 \austin.ukexz, . \FMP_BCFMI73,mxd Boggy_tt_Sec Default _ ) B‘
EE e Geodatabase: n.ukexas, eduldiskiengriresearchicrurstuc
Pathnames: v St relative pathnames to data sources
Thurnbrail: ke Thumbnail | Delete Thurmbnail |
Next, let’ d t. Navigate to File, «
ext, let's save our map document. Navigate to rile, « 0K | Cancel Apply |




® Boggy Creek Spatial.mxd - ArcMap

Fie | Edt ‘iew Bookmarks Inssrt  Selection  Geoprc
[ mew.. Cerl+n
ES Open.. b
& save Ctr+s

Save ds. ‘

Save A Copy...

Save As
share As
Save the current map vith a new

Add Data name of ko a different loeation,

BJ siontn

Next, add the Spatial files to the ArcMap Display. Select the Add Data icon, seen below.

Selection Geoprocessing Customize Wi
.\+, - I_ o
& Add Data...

Add Data

L1

[m/my ]
g a8

Add new data to the map's active
data frame.

In the Add Data pop-up window select “connect to folder”.

Add Data

Look in:

ﬁHome - My DocumentsYArcGIS @Trackjng Connections
EElFolder Connections

ﬁToolboxes

[ZlDatabase Servers

EEDaiabase Connections

@ GIS Servers

=My Hosted Services

[FIReady-To-Use Services

£ Interoperability Connections

MName: I
Show of type: IDamsets, Layers and Results LI LOEII

Navigate to the folder where your spatial files are stored and select add.

@Toolboxes Connect To Folder il

[ZlDatabase Servers
[GlDatabase Connections
@GIS Servers

Choose the folder to which you want to connect:

[E=IMy Hosted Services ™
@Ready—To—Use Services _' TESTZ
[l Interoperability Connections =118 Computer
=15 osDisk (C:)
J 365 Models
Name: I = | 365k Semester Project

. Boggy Creek

Show of type: IDamsets, Layers and ResL :
. AMD
. Brushy Creek
J Civil 3D Project Templates
. Civil 3D Projects
. EMGR-THIMAFPPS
. GIS Data x

Folder: I C:\365k Semester Project\Bogay Creek Spatial

Select the Sk Make New Folder | Cancel




x|

Look in: IE C:\365k Semester Project‘n,Bogg'j & i 3

Name: [B&Y_Stream_CL.shp; BOG_100yr_COA_FP.shp; BOG_25yr | Add |

Show of type: IDamsets, Layers and Results LI L‘Ill

Now you can view the modeled reach, its cross-sections, and various floodplains.

E = Layers
= BGY_Stream_CL

= Boggy_X_Sec

= ¥ BOG_100yr_COA_
[}

=2 BOG_25yr_COA_F
[}

You can turn layers on, and off by clicking on the check mark next to the layer’s name.



Table Of Contents

BEERE:

2]

El = Layers
= BGY_Stream_CL

= Boggy_¥_Sec

= [0 BOG_25yr_COA_FP
c
= Basemap
World Street Map

If you want to make the display more interesting, select Add Data,| b - and choose Add

Basemap. The Streets and Topographic maps are helpful for understanding the location of your
site on the modeled river.
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Go to the project data foLﬁe;r and get th



East Bouldin Creek 32472016 11:48 AM  File folder

East Bouldin Creek Spatial 372472016 11:48 AM File folder
ProjectSites 3/30/2016 9:27 PM File folder
Shoak Creek Spatial 3/24/2016 11:48 AM  File folder
Shoal Creek 3/24/2016 11:48 AM  File folder

Use Add Data to add the ProjectSites shape file to your ArcMap display

&b -|j[1:33372 v ]§| =
‘& AddData... I
= 82
i 2 | Add Data
BH
L Add new data to the map's active
= data frame. T

Tip: You can also drag data into
your map from the Catalog
window.

y & T

And you’ll see a ProjectSites feature class displayed

o =i Layers
Lot

@
(= Boggy_¥_Sec

= BGY _Strearm_CL

Which has a small dot to show your site. Click on this dot to open the Symbol Selector, and
make your dot larger so that you can see it more clearly on the map.



Symbol Selector

Type here to search

Search: (®) all Styles () Referenced Styles
ESRI
® | A
Cirde 1 Square 1 Triangle 1
Pentagon 1 Hexagon 1 Octagon 1

Color:

Size:

Angle:

v| Q @ EE «  Current Symbal

.-; =
The pan, zoom in, and zoom out tools, RS , are helpful to navigate to the site location.

Once you have located your site use the identify tool,
the model correspond to the inlet and outlet on your site. Right-click on the cross-sections
using the identify tool. This tells us that the inlet to the structure located at the intersection of
Boggy Creek, and Delwau Lane bounded by cross-sections 3208 and 3118.

Identify from:

- Boggy,_
. B0G3208

<Top-most layer> ¥

¥ _Sec

X5_LTR
WTR_NM

[&][T]
Location:  [3,137,747.691 10,068,27
Field | Value -
FID 132
Shape Polyline

X5_LN_ID  BOG3208

BOGGY CREEK -
4 I I 3

|Ider1tﬁed 1 feature

Identify

Identify from:

=1 Bpggy_!(_Sec
- BOG3118

, to identify which cross-sections in

<Top-most layer >

X5_LTR

3}
Location: |3,13?,82?.552 10,088,221 &
Field | Value -~
FID 183
Shape Polyline

X5_LN_ID BOG3118

WTR_NM  BOGGY CREEK _ILI
4 | | 4

|Idenhﬁed 1 feature

]



(2) Delineate the Drainage Area of your Project Site
Q Boggy - ArcMap
File | Edit View Bookmarks Insert Sel

[ MNew.. Ctrl+ N
% Open.. Ctrl+0

& Save Ctrl+5

Save As..,

Save A Copy...
Share As 3
Add Data 3

Sign In.. |
ArcGls Online...

J @ BERS

Page a| 2ign in or out of ArcGIS Online.

m m

In ArcMap, sign in to your UT Austin Organizational Account

In ArcCatalog (tab on right hand side of ArcMap document), expand the “Ready to Use
Services” to find the Watershed function



Catalog B X

S~ ol @ E-| s

Location: |‘;\% Watershed ~ |

= 5] Home - CE365KSpr16\Projects
£ Boggy Creek
£ Boggy Creek Spatial
£ ProjectSites

@ Boggy.mxd
£& Folder Connections
Toolboxes
fiJ Database Servers
£ Database Connections
B3 GIS Servers
{5 My Hosted Services
{73 Ready-To-Use Services (University of Texas at A
47 Elevation
7 Elevation
| Geocoding
= & Hydro

= E] Tools

= E Hydrology
‘{% TraceDownstream
‘{% Watershed

7 Logistics
47 Traffic
@ Tracking Connections

yaeas §[f | Goeies )

EEEHEHB

m

Click on this Watershed function, and in the open window, select a Snap Distance of 100 meters,
the FINEST source resolution data then move the cursor to the Project Sites point and click on it,
then say OK in the Watershed window. It takes a little bit for this function to run (you are



accessing digital terrain data in the cloud to facilitate this).

% Watershed

Input Points

Watershed:InputPoints
® InputPoints

Point Identification Field (optional)

Snap Distance {optional
100 |
Snap Distance Units
Meters
Data Source Resolution (optional)
TMEST

tiona

[ Generalize Watershed Polygons {optional)

[+] Retum Snapped Paints (optional)

[ ok ]| concel ||Envionments...| | ShowHelp »> |

=

o

You’ll see two new feature classes added to your project legend, Output Snapped Points and
Output Watershed. If you right click on Output Watershed and select Zoom to Layer, you’ll see

the drainage area of your project site. Pretty cool!!

i = layers 7 T ES
o S (I '4
B Output Snapped Points [¢f | . - ’/04@. @
i O,;‘ %1
= M ProjectSites ! ‘;
) £ =
= M Boggy X Sec = %z 8. - ;
o N i \ ! 4
=] BGY_Stream_CL < /8 ’
— 9% ~ Lake
W
5 e
= [ BOG_25yr. X Remove
0= B Open Attribute Table
= [ BOG_100yr Joins and Relates
=
o F B ¢ Zoom To Layer
World 1 —: Zoo7| Zoom To Layer
Visibl  750m to the extent of the selected 1
Uses| layer
Selection
Label Features
Edit Features
%5 Convert Labels to Annotation..
%o Convert Features to Graphics...
Convert Symbology to Repi
Data
& SaveAs Layer File...
&> Create Layer Package...

Let’s create a storage location for your project watershed.

Right click on the folder where you project files are stored in Arc Catalog, and select New File

Geodatabase

10




Catalog A X m
- eB@lE-mEod |9
Location: |ﬁ Home - CE365K5pr 16'Projects v| E
e =
B B Copy °
£s E
B3Pl w i
B
3 Folde
@ Tooll = Refresh
g Data | New 4 | £ Folder
£5l Datal ;
A7 Glss [tern Description... |l_] File Geodatabasze
[ My H ¢ properties... (3 | New File Geodatabase
E @ REEd_r T oOsT JOTVTETS ILUF"'I'CFbFL_'r F )
Cﬂ Elevation Q Create a new file gecdatabase,
44 Elevation

And name it Project.gdb. Then right click on the resulting Project Geodatabase and establish a
new Feature Dataset

£ ProjectSites Ed

3 P i

Bg B Copy ]
& Folden 1
Toolby % Delete
E@ Datab: Rename HL
E@ Datab ]
@ 515 Se e Refresh
(& My Hg L Make Default Geodatabase 17 7
[ Ready B H| |
3 Ele Administration O LU | i o :
A Ele Distributed Geodatabase * I ! :
A3 Ge —
= d: H}.| MNew r m'ﬁl Feature Dataset...

= B Import * D Mew Feature Dataset

= i
A g Create a new feature dataset.
i Share as Geodata Service...

Name the resulting Feature Dataset BoggyCk or whatever you want, and in the next screen,
navigate to the bottom of the display and in the folder called “Layers” select the Central Texas
State Plane Coordinate System (the legal standard for work in this area).

11



Mew Feature Dataset

Choose the coordinate system that will be used for XY coordinates in this data.

Geographic coordinate systems use latitude and longitude coordinates on a spherical model
of the earth's surface. Projected coordinate systems use a mathematical conversion to
transform latitude and longitude coordinates to a two-dimensional linear system.

q - | |T*r'|:|E here to search -

CUNVIN TR g ¢

£ State Systems
B3 utm
£3 World
£ World (Sphere-based)
= B Layers
@ MAD_1983_Centiguocus_USA_Albers
@ MAD_1983_StatePlane_Texas_Central_FIPS_4203_Feet
@ WG5S 1984 Web_Mercator_Auxiliary_Sphere

£

Current coordinate svstem:

Keep clicking until you hit Finish.

Now, lets put our Watershed into this Geodatabase. Right click on Output Watershed and

12



T ; r Luk
= | 1 ! \ustin
&1 & Copy B S
= [J BOG_25yr.CQ X Remove &£ . S
: & ®
(. B Open Attribute Table Y Z - S %
= [0 BOG_100yr_C . - S (8 > &
O Joins and Relates » 4 ~ 2
Ps = 3
= Basemap £’ Zoom To Layer = A S
& M World Toy ZoeirTo Make Vis & +
Visible Scale Range » :
Use Symbol Levels ;
4
Selection » ,
Label Features \ 7{'
Edit Features » \ , @ =
O o = 0
A 4. LOF . o
: Coy Austin 5
%g  Convert Features to Graphics... an ¢ oy
.).s
Convert Symbology to Representation... S v
I Data >|, Repair Data Source s
<> SaveAs Layer File... |(:4’ Export Data... ‘
Q) Create Layer Package... E Export Data
“f' Properties... " Save this layer's data as a shapefile

or geodatabase feature class

 V

Save your file as a File or Personal Geodatabase feature class called Watershed in the BoggyCk
feature dataset. You’ll be asked if you want to add it back in to ArcMap, and say Yes. Now
you’ve got something work with in determining the physical properties of your drainage area.

13



Saving Data

Lockin: [ Boggyck v 4 & ._f,"}| === "| E| El s B

Narne: Watershed | | Save

Save astyPe:  File and Personal Geodatabase feature dasses W Cancel

If you right click on the Watershed feature class and open its Attribute table, you can find the
drainage area of your watershed:

I

O B Copy
= [ B0G_25

r
)
I
2|
TRSSD S & &
_ D%‘OG 1003 Open Attribute Table & Z e 7 g
= ﬂ(}penkttributehble ’ Y RS g j \
$ . \j

Remove

B M Basemag @ 2 G this layer's attribute table.

@ M Worl Shorteut: CTRL + double-click
layer name OR CTRL + T. . o
3
Use Symbol Levels
Selection » - = = =
Shape * | Pour PointiD | Description | DataResolution | Area Square Kilometers | Shape_Length [  Shape_Area |
Label Features olygon | 1 [ NED 30m processed by Esri [30.0 [ 336159 | 115324629013 | 361806996.75264 |

Edlit Featurec o[BSl en s cac

Save your BoggyCk.mxd file using File/Save As in ArcMap to preserve your current project

outputs.

(3) Open the hydraulic model in HEC-RAS
Next we will open the creek model in HEC-RAS. This program is operational at the Learning
Resource Center. It can also be obtained directly from the Hydrologic Engineering Center at:

http://www.hec.usace.army.mil/software/hec-ras/ The latest version is HEC-RAS 5.0 which has
just come out. We'll use HEC-RAS 4.1 because that is what is loaded at the LRC. Navigate to

the folder containing the HEC-RAS model and if necessary, unzip it.

14


http://www.hec.usace.army.mil/software/hec-ras/

¥ a
N

| &,
Lk

HEG-FAS
4110

Double click on the HEC-RAS icon to open the program, . You will see a window like
the one below with many buttons laid out across the top. These buttons help you navigate to
the corresponding windows that display and describe your model.

HEC-RAS 4.1.0 Y [ 4|

File Edit Run Wiew Options GIS Tools Help

5 (5 2 e P 2 2 1 e [ 1
| =

Froject:

Plar:

Geometry:

|
|
|
Steady Flow: |
J
|

Unsteady Flow:

Description : ﬁ EI I LS Custamary Units

Navigate to the folder where your model is located, by selecting File > Open Project. Select
the .prj file associated with the model and select OK.

Title File Mame Selected Folder  Default Praject Falder Dacur

IEDG Creek |BDG.pri 4365k Semester Project Boggy Creek

e
23 365k Semester Project

& Bogay Creck

Cancel I Help I Create Folder ... I I =D ¢ [05Disk] j

Note: If you place the model in a network directory, HEC-RAS will not let you open the model.

Ras x|

This path is to & netwark directory, and will not waork this way, To use files
on a network directory, map a network drive (ike F:) to the desired directory
using the Explore program.

o]

15



Once you have loaded the project you will see the Project name, file path, plan, and steady flow
files.

B HEC-RAS 4.1.0 _||:||_|
File Edit Run View Options GIS Tools Help

7 e A Y s e e e T e PN R el E L M

Project; |BDG Creek Ic %365k Semester ProjecttBoggy Creek\BOG. prj

Plan: |E:-:isting Conditiohs |c.\355k Semester ProjecthBoggy Creek\BEOG.p04

[Geametny: |E:-:i$ting Geometry |c:\355k Semeszter ProjectBoggy Creek\BOG. q07

Steady Flow: IE:-:isting Flaw ||::\3I35k Semezter ProjecttBoggy Creek\BOG.f04

Unzteady Flow: | |

Description : Il_l pdate by: ATKIMS February 2013 ﬁ EI I US Customary Units
To view the profile of the reach: .

a

(1) Click on the View profiles button,

(2) Study the Profile Plot. What do you notice? The x-axis shows the distance upstream
from the most downstream cross section while the y-axis shows the elevation. The
legend shows the Energy Grade line, EG, the Water Surface line, WS, and Critical Depth
line, Crit.

(3) Close the Profile Plot window.

- .Profile Plot [ _ (O] x|

File ©ptions Help

Reaches .. | 8| Profies .. |[][e] ™ Pl Iniial Condiions _Reload Dat |
BOG Creek Plan: Existing Conditions  5/14/2013 | =

Bogay 1 |
5004

Legend

WS FEMA_2_YEAR
i PR TR

Ground

Elevation ()

o 10000 20000 30000 40000

Main Channel Distance () -
i »
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To view the cross sections along the reach: .
==

(1) Click on the View cross sections button,

(2) In the Cross Section window you can cycle through all the cross sections in the model by
clicking on the arrows next to River Sta. at the top of the window. Scan through the
Cross Sections until you find your site. Remember which river station is for later
reference.

(3) If you start at station 0 and move upstream, do you notice the water surface changing?
Like the Profile Plot, you will see the EG, WS and Crit lines plotted.

Crass Section =] ES
File ©Options Help
River IBogg_l,l j LI@ |75.67. 47213 + ﬂl Reload Data
Reach: |1 =] Riversta: [ECEMCENMGENENE -] 4| 1

BOG Creek Plan: Existing Conditions 51472013 -
Delwiau Lane (BRO1); effective model used normal bridge (energy o
5207 Legend
W FEMA_2_WEAR
- -
Ground
500
Ineff
*
Bank Sta
4801
£
5
& 4604
=
)
w
4407 Jr
b 1 o of
4201 \\—| X
400 T T T T T !
-500 -400 =200 a 200 400 E00
Station () -
arl v

(4) Close the Cross Section window.

Finally, we can look at some rating curves created by HEC-RAS to gain a further understanding
of the analysis.

17



To view rating curves:
(1) In the main HEC-RAS window, click on the View General Rating Curve button, .

(2) The Rating Curve window will open and you will see a graph of the channel velocity as a
function of upstream distance. Navigate to your site’s rating curve. This will help you
understand the relationship between stage and discharge at your site.

=

File Options Help

Fiver. [ | ¥.|©] 48] _Feload Do |

Feach: |1 | RiverSta: [3183 BRU DELwWAU ~| 8] 1]
BOG Creek Plan: Existing Conditions  3/23/2016 -

Delwau Lane (BRO1}), effective model used normal bridge (energy o

435_: Legend

4307 W.S. Elev

425-;
420-;

4159

WS, Elev ()

410-;

405

4I:||:|-----|----|----|----|----|----|
0 s000 10000 15000 20000 25000 30000

(1 Total (cfs) =
= | r
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Open the Bridge Output table:

(1) In the main HEC-RAS window, click on the Bridge Output button,
(2) Navigate to your site’s Reach Section (RS).
(3) Change the profile to the storm you are designing for.

This table has information about the velocity, flow, and channel depth at your cross-section.

! EEBridge Output M= E3

File Type Options Help
 River. |Boggy | Profile: |FEMA_2 YEAR |

| Reach I'I | RS HJ Plar: IEHisting j

| Flan: Existing Boggy 1 RS: 3163 Profile; FERA, 2 YEAR

| E.G. LS. [ft] 425 58 | Element Inzide BR U5 | Inside BR DS
WS, LS, [ft) 42521 | E.G. Elev [ft] 424 83 424.M
(1 Total [cfs] B436.00 | 5. Elev [f] 422119 42217
(1 Bridge [cfs] B436.00 | Crit w5, [f] 41652 41399
[ “weir [cfz] hdax Chl Dpth [fE) 18.40 18.85
Weir Ska LFt [ Vel Total [f2s] 13.04 10,87
Wweir Sta Rt [ft) Flows Area [zq (] 493.48 53205
Wweir Subrerg Froude # Chi 054 044
Wweir Mar Depth [ft] Specif Farce [ou f] F010.65 823675
kir Eleir Flow [ft) 42363 | Hydr Depth [ft]
hin El Prs [ft] 41986 | . P. Total [ft] 93 56 107.21
Delta EG [ft] 200 | Cony. Total [chg) 47633.9 B1073.6
Drelta "5 [ft] 284 | Topwidth [ft]
BR Open Area [=q ft] 493.48 | Frctn Lossz (/] 04z 011
BR Open ‘el [ft/2] 1304 | C&E Loss [ft] 0.40 0N
Coef of [ Shear Tatal [Ib/zq f] 5.E9 383
Br Sel Method Energy only | Power T atal [IbAft g -A30.04 B29.77
Errors, " armings and Motes
Warning: The welocity head haz changed by more than 0.5 £ (015 m). This may indicate the need for additional cross sections.
Mate: Multiple critical depths were found at thiz location. The critical depth with the lowest, valid, water surface was uzed.
Warning: The velocity head haz changed by mare than 0.5 ft [0.15 m]. This may indicate the need for additional cross sections.
Warning: The convepance ratio [upzstream conveyance divided by downztrearn convepance] iz less than 0.7 or greater than 1.4,
Thiz may indicate the need for addiional crozs sections.
Minte: Multinle criticAl drnths were finnd At this lncatinn The critical denthowith the loaest walid water zuface was nsed LI
Select River Station

Save your HEC-RAS file before closing the program.
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